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Editor’s Letter Welcome to 2dartist issue 111! Welcome to another issue of 2dartist! For anyone interested in stylized designs, this one’s for you. We meet a rising star in the digital art world, Mike Azevedo; learn industry tips from this month’s cover artist, Amin Faramarzeyan; admire Fernando Forero’s detailed sketches; and Simon Dominic introduces Painter 2015’s newest features. JESS SERJENT-TIPPING Deputy Editor



With a host of helpful tutorials, stunning artwork and useful advice, we hope this issue has everything you need to be inspired and creative this month. Enjoy!



KEEP UP TO DATE WITH 3DTOTAL!



facebook.com/3dtotal facebook.com/layerpaint twitter.com/3dtotal twitter.com/layer_paint youtube.com/ 3dtotalpublishing vimeo.com/3dtotal vimeo.com/layerpaint pinterest.com/3dtotal instagram.com/3dtotal google.com/+3dtotalcg



Contributors
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MIKE AZEVEDO Mike is passionate about telling stories with images and is currently working as a freelance concept artist and illustrator for game companies. Mike also teaches painting classes in Brazil.



ILYA DYKOV Ilya Dykov is a freelance 2D artist, who achieves a traditional painterly feel to his images. Ilya guides you through his thought process when speed-painting to a brief.



AMIN FARAMARZEYAN Amin is an illustrator and art director who loves visual arts. Amin has been working in the advertising field for more than 10 years. Projects he’s worked on include 2D and 3D animation and games.



SIMON DOMINIC Simon Dominic is a self-taught illustrator who specializes in fantasy and horror themes. For the past three years he has worked mainly on illustrations for social gaming projects and collectible card games.



FERNANDO FORERO Fernando Forero is a Colombian graphic designer, illustrator and typographer based in Poland with over 16 years of experience. Currently he’s working as GUI artist for the videogame developer company CD PROJEKT RED.



RAFA ARSEN Rafa ArSen was born in Córdoba City, Spain. He studied Illustration and graphic design in art school and works as a graphic designer and illustrator. He demonstrates how to paint a stylized pin-up girl.



FLORIAN AUPETIT Florian Aupetit is currently working as an art director and a 3D generalist at the Parisian studio Monsieur K. He is also currently working on a personal animated short film called Father & Son.



WOULD YOU LIKE TO SUBMIT TO 2DARTIST? We are always looking for tutorial artists, gallery submissions, potential interviewees, writers and more. For more information, please send a link to your work to: [email protected].
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Deputy Editor Jess Serjent-Tipping [email protected] Sub Editor Adam Smith Graphic Designer Aryan Pishneshin Publishing Co-ordinator Adam Smith Advertising Manager George Lucas [email protected] Studio Manager Lynette Clee [email protected] Managing Director Tom Greenway Advertising Media pack and rates are available upon request. Contact George Lucas: [email protected] International Translation opportunities and international licenses are available. Contact Melanie Smith: [email protected] Subscriptions Subscriptions can be purchased via 2dartistmag.com. 12-month subscription – £23.99 ($38.99 US approx.) To enquire about subscriptions, contact: [email protected] Distribution 2dartist is an e-magazine distributed as a downloadable PDF and on digital newsstands.



Magazine. Your



Get the most out of it!



If you’re having problems viewing the double-page spreads that we feature within this magazine, then follow this handy little guide on how to set up your PDF reader!



Top tips for viewing



For optimum viewing of the magazine, it is recommended that you have the latest version of Adobe Acrobat Reader installed. You can download it for free here: To view the many double-page spreads featured in 2dartist magazine, you can set the reader to display “two-up”, which will show double-page spreads as one large landscape image: 1. Open the magazine in Reader; 2. Go to the View menu, then Page Display; 3. Select Two Page Scrolling, making sure that Show Cover Page in Two Page View is also selected.



Jump to articles



In the Contents pages, we have direct links to all articles within the magazine. If a certain article catches your eye, simply click (or tap on handheld devices) on the page number within the Contents, and you will be taken straight to that article.



Download resources



Whenever you see this symbol, be sure to click it to download free resources to accompany that article!



For lots more tutorials and exclusive articles, visit



www.layerpaint.com



Disclaimer All artwork, unless otherwise stated, is copyright ©2014 3dtotal.com Ltd. Artwork that is not copyright 3dtotal.com Ltd is marked accordingly. Every effort has been made to locate the copyright holders of materials included in this issue of 2dartist magazine in order to obtain permissions to publish them. Special thanks to 3DHype, Hiperia 3D and Veegraph for supporting 2dartist with banners. Contact George Lucas if you would also like to show your support: [email protected]



2dartist magazine is available as a downloadable PDF magazine. If you have an iPad or iPhone, you can drag your magazine into your iTunes library – it will automatically add the PDF to your bookshelf in your iBooks app!
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Amin Faramarzeyan shares a selection of his unique artwork and invaluable advice



036_ The gallery



Max Kostenko and Even Amundsen feature in this issue’s gallery selection of our top 10 images
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Take a peek at Fernando Forero’s detailed drawings in the pages of his sketchbook



074_ Speed up your workflow



Florian Aupetit demonstrates how to increase your productivity with speed-painting skills



084_ Improve your painting practice



Ilya Dykov guides you through his thought process when speed-painting to a brief



092_ Discover Painter 2015



Simon Dominic paints a fantasy scene demonstrating the new functions of Painter 2015



104_ Create a pin-up illustration



Rafa ArSen gives us a detailed walkthrough of his Photoshop process



114_ Master stylized creations



Amin Faramarzeyan takes you through the stepby-step process used to create his illustrations
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Bram ‘Boco’ Sels reveals top techniques for figure drawing and painting realistic skin textures
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 The Artist



Mike Azevedo pkmike.tumblr.com Interviewed by: Jess Serjent-Tipping Mike is passionate about telling stories with images and is currently working as a freelance concept artist and illustrator for game companies. Mike also teaches painting classes in Brazil.



Rising star of digital art



Mike Azevedo creates stunning fantasy work with the awesome combination of great color palettes, character design and lighting. He shares his inspirations, experiences and journey into the digital art world
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With his perfect combination of color, character design and lighting, Mike Azevedo is one of the rising stars of the digital art world. An illustrator and concept artist from Brazil, he works mostly for game companies, with clients including Applibot, VOLTA, Riot Games and Guerrilla Games. He also teaches digital painting classes in Brazil as a mission to develop the industry and education there. He will also be speaking at this year’s Trojan Horse was a Unicorn festival in Troia, Portugal. We caught up with Mike to chat about his journey into the videogame industry, his inspirations and what he’s looking forward to at THU/2015. 2dartist: Tell us about you background and journey? Where did it all begin? Mike Azevedo: I began my career like many other artists, by drawing since I was a little kid, watching cartoons and using crayons to imagine different worlds and situations, basically what I still do today. My family was always very supportive of my drawing



Ancient Prophet © Mike Azevedo
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and when the time came I decided to make this my profession, but of course I had to prove that I could earn a living from this. It wasn’t so easy at the start, mostly because the art education in Brazil is not very good, but fortunately my desire to work with what I love was bigger than the barriers. I started studying every day at home and pursued this career. 2da: When you were just beginning, what helped you the most in terms of a learning process and gaining invaluable experience? MA: The constant studying is what helped me the most during that time. It’s very easy to fall into this mind set of thinking “you’re not good enough,” but always being consistent about studying really helped a lot to realize exactly what you fear the most about drawing, and what are the hardest things for you, and just go for it – you don’t have to show it to anyone. Constantly leaving your comfort zone and trying new techniques and approaches to painting and drawing, I still find myself doing this today, and probably will do it forever.



2da: What is your biggest source of inspiration? Is there a particular style, mood or scene that you are drawn to? MA: I’m definitely very inspired by games, I always loved playing them as a kid and a lot of games are big memories of my childhood. When I’m thinking about what to paint I always try to think about “what kind of scene would I like to see in a game?” or something like that. I like painting things that involve different cultures. One thing that I really like to play from time to time is the idea of a world of tiny people, hiding from normal sized people, like Arietty from Studio Ghibli. 2da: What is your favorite image (that you’ve created) to date or project that you’ve worked on and why? MA: I don’t think I have a favorite image of all time; I had a lot of fun doing a lot of them. I really enjoyed the process of the dragons I painted. The forest dragon sure was very relaxing (and time consuming).



 Where are you little creature © Mike Azevedo



 Scout © Mike Azevedo



 Artist Timeline Mike’s career so far 2008: First Tablet 2010: Finding out about conceptart.org sketchbook threads 2011: Gained his first international Freelance work 2011: Joined the Crimson Daggers group 2013: Started teaching digital painting in Brazil



Tony, The dragon © Mike Azevedo
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Surprise © Mike Azevedo



The Gauntlet piece I did for a Crimson daggers challenge was very helpful to learn; it was kind of a breaking point too, because I realized I could try other styles in painting and have fun and paint things the way I want – this is important. Before that I was trying to follow a lot what everyone was doing and trying to emulate that, so that was an eye opening piece, regarding projects; I really enjoyed working freelance for Riot Games, it was super demanding, but also a great learning experience. 2da: Can you take us through your typical work process? What tools do you use to get from an idea to a professional finished piece? 2DARTISTMAG.COM



MA: When I’m thinking about ideas, as I said before, I like to focus on “what do I want to see?” I try to avoid thinking about other people’s opinions and ideas, because I want it to be as true as possible to myself.



tool, Color Dodge layers, and Hard Light layers really help a lot to add contrast during the process, because I start with a very dull light. 2da: What are you looking forward to at THU/2015?



While painting I like to see what kind of process would fit better. Sometimes I do lineart and sometimes I jump straight to brushstrokes. I don’t have a set number of steps that I repeat every time, as I find that to be a bit boring. I like to explore as much as I can when I paint something. I like to sketch some ideas using printing paper to figure out some main elements before jumping to the final image. I like to build up the contrast, so tools like the Dodge



MA: The main thing is meeting other artists that I have admired for so many years online, and talking and sketching with some of my favorite artists. I’m sure I’m going to learn a lot just by being around everyone at the event. I am looking forward to that atmosphere of passion to learn. I’ve never been to such a big event in terms of number of artists and big names of the industry in one place. I’m sure I’m going
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to smile all the time not believing my luck – I’m very honored to be joining as an instructor this year. 2da: Are there any areas in the digital art world that you’d like to branch into (and why)? MA: I’d love to one day make a game; as I said before, I grew up playing games and trying to imagine new worlds and possibilities, so I’d love to develop a game with my own ideas and concepts for the characters/environments. It would also be fun to make an artbook – I’ve had a bit of experience with that, but never actually made it fully happen. I hope someday I can do it. Printing, shipping and working



a lot with client’s ideas makes me want to try it for myself too, and almost all the books I own are artbooks, so I have a lot of ideas of what I want to do with mine. 2da: It’s always good to take time out from work and reflect. What do you like to do to relax? MA: I like to go to a good restaurant, hang out with my friends and my girlfriend. I love watching a good movie. I actually learn a lot about storytelling and composition watching movies, and I actually like to sketch when I don’t have work to do. Just sketch with no pressure. I say that because it doesn’t feel like



work at all when I’m doing this, it’s very refreshing. Sometimes I also like to watch game streams and I enjoy DotA competitions, such as The International, they are super thrilling to watch; unfortunately I don’t find time to play it. 2da: If you could give future digital artists just one piece of advice on working in the industry, what would it be? MA: I’m sure I’m forgetting something, it’s hard to give one piece of advice that will always work, but I’d say if you want to become a digital artist you have to be willing to fail a lot of times. It’s important 15
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Princess breakfast © Mike Azevedo
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Elephant profile © Mike Azevedo



“It’s very important to always stay humble about your current level, enjoy the actual moment instead of thinking about how you aren’t good all the time” not to lose, but gain courage and dedication with each failed painting, I know I had to do thousands of paintings to get wherever I am and I still plan to do a lot of them to get better. It’s very important to always stay humble about your current level, enjoy the actual moment instead of thinking about how you aren’t good all the time. Paintings are affected by your mentality and having a good mentality is a great way to start. 2da: Finally, what can we expect to see from you in the future? MA: I’ll try to always make time to practice and do my own sketching, I find that I have much better days when I sketch or do something for myself. I’m going



PRO TIPS Patience with light



Something that helps me to deal a lot with light is ignoring it in the first part of the image; I find it better to establish the structure, anatomy, and gesture before moving to the next step. Light is really dependant on the form, so making sure the form is correct is the best way to start the lighting process of a painting, it saves a lot of time that I’d spend ‘fixing the mistakes.’



Juggling



I like to make the comparison between juggling and painting and I know it’s weird; I do this because in juggling it’s easy when you’re dealing with fewer objects and harder when you’re juggling 10 balls. So when painting try to think in the same way, deal with one fundamental at a time, don’t try to nail everything at once because you’re just making it harder to do, and just be patient and focus on each part. 90-percent of the bad paintings I do are due to rushing the process and jumping to other parts that are not ready to be developed yet – do one thing at the time, it’s not a race, it’s a painting.



to be better about events and stuff and I hope that I’ll be attending more events, such as IFCC and THU in the coming years. I plan to continue teaching here in my country – I’d really like to help to develop the industry here, as it’s pretty rare to see Brazilian game



projects at the moment, but It’s hopefully going to get better – it’s already changed from a few years back. You can also expect me to do more tutorials and projects; I will always try to keep the motivation to do these! 17



 Warrior fairy © Mike Azevedo



 The Artist



Amin Faramarzeyan artstation.com/artist/aminfara Interviewed by: Jess Serjent-Tipping An illustrator and art director who loves visual arts. Amin has been working in the advertising field for more than 10 years. Projects he’s worked on include 2D and 3D animation and games.



The secret to a signature style



Illustrator and art director, Amin Faramarzeyan shares a selection of his unique artwork and chats about his journey into the industry and what inspires him
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Amin Faramarzeyan is an Illustrator born in Iran and now living in Dubai, United Arab Emirates. He has a very personal interesting style, using geometric and polygonal shapes to create vibrant illustrations which often contain a dose of humor! We caught up with Amin to chat about his signature style and inspirations as he shares a selection of his brilliant work. 2dartist: Hi Amin, thanks for chatting with us today. First, could you tell our readers a little bit about yourself and your background in digital art? Where did it all begin?



2DARTISTMAG.COM



Amin Faramarzeyan: Thank you. I have loved drawing and painting for as long as I can remember. Instead of going to normal schools I went to graphic design technical school after my secondary school. I had a chance to live my dream life when I was 14 or 15 years old; I met so many young and ambitious artists in that school and I still think that place was magical somehow! Regarding digital art, I was 16 when my older brother bought a computer. I was so into traditional art like painting with quiche or watercolor and when my brother showed me Photoshop I immediately fell in love with it and started to paint digitally



using a mouse! I still draw in sketchbooks and love traditional medium, but really enjoy the flexibility of digital medium. I’m also a big fan of technology! 2da: What was it about the digital tools that made you want to pursue a career in the industry? AF: More or less it’s flexibility, basically you have a freedom to correct things pretty quick which can be a bad thing sometimes! But in general, working with the latest technology is always fun if you can afford it obviously, it’s like hey man do you like to draw? Here is a pen that can draw in millions of colors! It’s very tempting. On the other hand it was quite clear
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that this new world is becoming bigger and stronger. Simply put I enjoy working digitally. I could also see my friends and colleagues using the digital tools more and more back then. 2da: What is your biggest source of inspiration? Is there a particular style, mood or scene that you are drawn to? AF: Like so many other artists I get my inspirations from various sources, to mention a few: people, nature, other amazing artists (any field of art), sport, politics and society, traveling and the list continues. Maybe the biggest source is people; they are



fascinating; we are very complicated creatures and therefore interesting to observe and get inspiration from. Sometimes I go out and a nice breeze hits me, all of a sudden I’m inspired! This subject is still very unclear for me. I love anything in animation or cartoony style! It’s my favorite because it captures the essence of things. I’m drawn to anything that makes me think, that’s why I love stories. 2da: You have a distinct style which is very recognizable, how did you develop this particular signature style?



AF: Thanks a lot that means a lot to me. Basically you always have your style and you are simply not aware of it! The reason could be all the noise around you or lack of knowledge so you spend a good chunk of your life learning and growing while achieving that sense of self trust to do the things you always loved, then you let go of your fear and start doing what you believe in. It was the same for me, learning the basics like form, anatomy, light, and so on, then realizing that I don’t know enough and I have to fasten my seatbelt for a long journey of learning and growing. One other thing maybe is because I always wanted



Black Afternoon ‒ using Photoshop, Amin started to color his sketch, trying to achieve a clear foreground, middle-ground and background23
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A little hedgehog got his hair trimmed! Amin started with a sketch which he liked then turned it into this illustration
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Writers Write - After visiting an old friend Amin fell in love with his creative process so he made this piece
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to be different in what I do by finding my voice. It’s funny how hard we try to slowly learn some simple concepts of life! Maybe that’s how it works! 2da: Could you choose one of your favorite past images (that you’ve created) and explain how you created it, and why it’s your favorite? AF: Usually when I finish something I start to see issues and problems and I go crazy! But if I have to choose one, I will go with the Little hedgehog in the barber shop.



PRO TIP Stay true to yourself



The thing is there are so many amazing artists out there and it’s always been like that, but the key is to not get disappointed or give up. You don’t even have to compete with other artists; instead try to find your own strength and voice. No one can help you grow better than yourself. If we all stay humble and work hard we will see our progress clearly. It’s a journey and there is no end to it as far as I understand! So we have to find a way to enjoy it as much as possible.



Mine ‒ An illustration created from a nightmare Amin had about a character



I started with a little sketch in my sketchbook then in Photoshop I made all the shape layers and then tried to add light and shadow to those shapes. I then added colors and from this stage onwards I finalized things and made the light and color work together to help tell the story of an illustration. I like the sense of humor in that piece; also I could see myself sitting in there and enjoy the show! 2da: Are there any areas in the digital art world that you’d like to branch into (and why)? AF: This one sounds simple, but is difficult to answer so I’ll try my best! One thing I feel about the digital world is its growth approaches the speed of light! So imagine five years from now what sort of digital art platform we will see and have! I don’t know. I can say I love to tell stories, so a digital graphic novel or a printed one would be my ultimate goal now! Also I have never stopped loving the animation art form. My dream right now is to make a great high quality book, something valuable, and I hope I can prepare the necessary factors to make this happen. So to answer your question, I’m thinking branching into the animation world and also graphic novels specifically in the form of an app or something. 2da: How do you spend your free time away from the demands and deadlines of the creative industry? AF: I try to care more about valuable things like the people around me and family or friends. I go to nature whenever I get a chance that really refreshes me; also traveling to my home country is great. Sometimes I draw fun stuff and watch as many



Artist Timeline Amin’s career so far 2001: Amin started as a junior layout-man at Saba Animation Co.



2007: Started as a compositor and motion graphic artist at Clockwork..



2013: Art director and character designer for Cartoon Network Arabia



2003: Created Ghoore, a little 2D animation that received a small award!



2009-present: Joined Optix as an art-director



2014: Art director and visual development for preproduction on a LEGO TV series.



2003: Became storyboard man and part of the visual development at Saba.



2011: Art director for the award winning commercial for Emirates Airline..



2014: Illustrator and designer for Motiga’s promotional artworks. 27
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Metro Accident ‒ Amin spent some time designing the composition and then worked his way up towards colors and finalizing
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Something fun Amin did for Halloween; he tried to tell a little story with the girl in this piece
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 Another nightmare Amin’s thestyle skull head character now 2DARTIST MAGAZINE | Theofsecret to a with signature wearing a police uniform. He tried to use a simple palette



“Be strong and flexible, learn digital tools and appreciate traditional skills” movies as I possibly can! I’m planning to become an independent artist, so I can work with my own deadlines and schedule just because no one can plan your life better than you (imagine if I mess up planning mine, then I have to come back to you and beg you to remove that line!) 2da: What has been your favorite commission/ project to work on so far and why? AF: A couple of months ago I had the chance to work on certain posters and promotional artworks for 2DARTISTMAG.COM



the game Gigantic, and honestly this was my best commissioned project so far. They gave me freedom to come up with my own things; they wanted my style and didn’t push the work into strange territories like the changes that unfortunately some clients do which ends up with broken artworks! It is rare that people ask for my style and they told me it’s mainly because it is very different, although that’s not good news for me commercially, but I take it as a compliment! It’s my responsibility to do something with it. 2da: If you could give future digital artists just one piece of advice on working in the industry, what would it be?



AF: First of all, I have to say love you all because you are trying and working hard! I tell you this as a friend; work hard and have fun at the same time, work for the industry and don’t, learn the foundations and break them, be strong and flexible, learn digital tools and appreciate traditional skills. Learn light and understand the darks! These two, sometimes opposite things, can hopefully give you a sense of balance in your life. It’s extremely easy to fall off of one side of the cliff, the challenge is to stay in balance and stay sane! I wish you all a hefty amount of luck and health. 2da: Finally, what can we expect to see from you in the future?
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AF: Actually when you live in the Middle East, probably the most difficult thing you can actually do is plan your future! But I know that so many other artists all around the world are struggling with countless other problems and issues as well. I have wishes that I hope will come true one day with my hard work and hopefully consistency. First of all a graphic novel and after that maybe some short animation demos, I will also do my best to make some cool looking characters and stories. Thanks a lot again to you and your readers. I hope we all sketch together somewhere in a dreamy land with unicorns and free ice-creams that don’t make you fat!



PRO TIPS Style is not everything



Just a little note on style, it’s always fun to come up with your own thing, but it’s not a must. I know some friends who work in the industry and don’t necessarily follow a certain style and they are very successful. Every artist has some sort of style in his or her work. If you love to do crazy things then by all means do it and see where that will take you.



Knowledge vs. repetition



Learn, learn and learn. Life is filled with lessons to learn, so many opportunities to take, countless challenges that can help you shape your character as an artist or anything else. So imagine if you throw all of those priceless options away and copy other artists and just repeat what they have already done. It’s just a waste of time to me unless you want to learn something from those artists. Learn and use your time for discovering new things. Knowledge is always a winner.
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 © 2014 NewTek, Inc. LightWave is a trademark of NewTek. All rights reserved. All other marks are the property of their respective holders.



Image - Lorenzo Zitta



Download the free trial at www.lightwave3d.com



Italian digital artist Lorenzo Zitta knows how to create thought provoking still images with LightWave 11.6. Whether the still is computer-generated with LightWave, an artful arrangement of digital photos, or a combination of the two, the composition of the scene – with its attention to detail and unusual merging of objects – demands a closer look. “Thanks to LightWave, I can quickly test many different approaches for my projects. I love bringing models into Layout and switching on Radiosity, then start working on shading and lighting, bringing in more elements, and testing and improvising to get the look I want.” - Lorenzo Zitta.



By artists for artists.
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Each issue the 2dartist team selects 10 of the best digital images from around the world. Enjoy!
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Submit your images! Simply email [email protected]



Fungal Overgrowth Marco Gorlei Year created: 2015 Software used: Photoshop Web: mgorleidesign.tumblr.com
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 Rubik Space Quest Markus Neidel Year created: 2014 Web: markus-neidel.de
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Over your Te shoulder Honunui Even Mehl DaneAmundsen Madgwick Year created: 2014 Web: artstation.com/artist/mischeviouslittleelf Web: danemadgwick.com
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En Garde Markus Lovadina Year created: 2014 Web: malosart.blogspot.co.uk
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Little story Kolobaev Mark Year created: 2015 mous.squarespace.com © Mousart
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1920 - survivors Jakub Rozalski Year created: 2014 Web: artstation.com/artist/jakubrozalski
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Robocat Max Kostenko Year created: 2015 Web: max-kostenko.com
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Have a Nice Day Wadim Kashin Year created: 2014 Web: septicwd.artstation.com © W.D.
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Drone Alex Nice Year created: 2015 Web: alexnice.com © Alexnice2015
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Oedipus and the Sphinx Víctor Adame Mínguez Year created: 2014 Web: victoradameart.com Illustration © 2014, Víctor Adame Mínguez



2DARTISTMAG.COM



 2DARTIST MAGAZINE | ISSUE 111



Futuristic slums Jean-Guilhem Barguès Year created: 2014 Web: artstation.com/artist/chillpill © Jean-Guilhem Barguès
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The Artist



Fernando Forero



fernandoforeroart.com Fernando Forero is a Colombian graphic designer, illustrator and typographer based in Poland with over 16 years of experience. Many of his personal works have won international awards and have been exhibited at various events and countries. His artworks are constantly reviewed in publications of art and design and are currently featured in specialized blogs of design and/ or illustration thanks to the expressive quality of his work. Currently he’s working as GUI artist for the videogame developer company CD PROJEKT RED, and as a freelancer for many others across the globe.



 Sketchbook of Fernando Forero Take a closer look at Fernando Forero’s fantasy sketches... I started to work constantly in sketchbooks more or less 16 years ago, motivated by heavy and dark emotional states that surrounded me at the time. As I dedicated my time to exorcise my emotions on the blank pages of my sketchbooks, I found a sort of self therapy that I still have today when drawing. So drawing becomes a sort of meditative contemplation, as a sort of ritual. At the very beginning I experimented on every page of my initial sketchbooks in reflection of the different states of my depressions, but with time, the constant exercise of working gave me the strength to try different ways to find myself as an image creator. Today I’m guided by my personal aesthetic values and intuition when drawing. My sketchbooks with annotations and imaginary creatures contain emotional dialogues that possess symbolic values as an added value of metalanguage, which becomes the powerful motor of my work. Inspiration and ideas When working in my sketchbook I never have a preconceived idea of what I want to accomplish; I approach the white pages with a deep need to draw, so I let myself be guided by my emotions and visual instincts; just leading by my personal aesthetic values. When starting to create my drawings the image is created from lines and basic shapes, which I develop into a picture rendered with detailed passion, an image (a creature in most of the cases) that at the end clearly possess a strong identity which could be called my personal style. I personally do not believe in inspiration, I think that inspiration comes from working and judging what is best for the image in order to generate specific impact and attention. On the other hand what activates that need to draw can be a sentence, a word, a song, a comment, a feeling, a problem, or something that impacts my sensitivity.
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From a series of 10 illustrations called BESTIARY



PRO TIP Draw things you don’t know how to draw Once you have regular practice of making drawings, you will notice that most of the time you draw the same things or subjects, so it’s good to invest some time into drawing new things that you don’t know how to draw. It will make your skills stronger, as well as teaching you to see more.
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 Sketchbook of Fernando Forero Materials When I lived in Colombia I was selecting specific papers with different qualities depending on my needs and I took them to a friend of mine to bind into a sketchbook. When I moved to Poland I started to buy bound sketchbooks in shops, where the quality often suffered to support acrylic or other paintings, forcing me out to draw exclusively with ballpoint pens. In general, in many of my different fantasy art sketchbooks, I prefer drawing with pencil, because with it I can create things faster and at any time, anywhere. I always have with me three different pencils: 2H, HB and 2B, which I use depending on the image. Over the last two years I have been using ballpoint pen to sketch things from reality, capturing what my eyes consider is interesting. Sketching techniques First I draw a few simple lines composed as an organic movement over the paper and from there I start to create a more elaborate picture rendered with details and volumes. In principle I am driven by my intuition, then led by my experience and values I let the image flow. So, first I compose the general image in the format of the page and finally I add additional loose texts that are comments, or ideas that cross my mind and my emotions, which may or may not be linked to the image. I also add numbers as fake series and sometimes I add mail stamps or other paper found on the street. So I keep my work in a symbolic sphere, where every part helps to construct an imaginary story. I like to work in this way because I feel it is honest and connected directly with my senses and feelings.
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From a series of 10 illustrations called BESTIARY A yachting fan asked me for a custom illustration of a compass. The idea of the project was an octopus entangled in the middle of the compass
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 Sketchbook of Fernando Forero



I love birds, so from time to time I like to draw them in different manners, in this case a drawing of a crow dressed in an imaginary Victorian style I like to decorate the feminine figures of my imagination with headdresses My latest sketchbook is the biggest in my personal collection, so in it I’m trying to create big images rendered with more of an anatomical sense of 3D, and trying to improve my drawing skills
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 Sketchbook of Fernando Forero
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 A personal version of a dragon, exploring a sense of 3D in the render I love different animals, and fishes are one of my favorites from their aesthetic shapes. This was from a photo I took of one in a store
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 Sketchbook of Fernando Forero This illustration was made for an exhibition with a selected group of Colombian illustrators This work was done traveling alone in a train between two cities in Poland
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 Sketchbook of Fernando Forero



PRO TIP Just be yourself



The better way to stand out in the industry is to just make things as only you can do.
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This illustration was made with a ballpoint pen on paper and was inspired by Diana Krall’s song ‘When I look in your eyes’ A personal illustration from my sketchbook A small illustration just for fun
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 Sketchbook of Fernando Forero



This illustration is the base for a work made for an artistic exhibition called ‘Los Visitantes’ (The Visitors) in Mexico D.C. Another character from my imagination Exploration of a face with organic elements
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 Sketchbook of Fernando Forero



Sometimes I love to play with tea in my sketches This is one of my recent drawings where I’m trying to improve my knowledge of anatomy by mixing it with my intuition when I create my various characters A short time ago during the winter, while walking to the office, I turned my head to the trees on the side of the street and the view of the old trees inspired me to create this image
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 Would you like to see your sketches featured in 2dartist magazine? We’re always on the lookout for talented artists and their artwork to adorn the pages of our magazine. If you think you have what it takes, get in touch! To submit, simply email Jess at [email protected] with a selection of your images or a link to your portfolio online, plus a little information about you. We look forward to hearing from you!



 3DTOTALPUBLISHING



An innovative and fun way for people of all ages to find the inspiration to pick up a pencil – and draw! The Sketch Workshop incorporates a luxury leather-style folder that can securely hold a workbook and up to 20 quality drawing tools. We’ve created a number of workbooks that cover popular topics including:



Designed to be easy to carry and use on the move, this beautiful art resource offers a complete sketching solution for beginners, hobbyists, and artists looking to brush up on drawing skills, with tuition by pro artists.



FOR MORE INFORMATION ON THE FOLDER, WORKBOOKS, AND DRAWING TOOLS AVAILABLE, PLEASE VISIT: SHOP.3DTOTAL.COM



AVAILABLE NOW!



 SPEED PAINTING CHALLENGE Professional artists often need to schedule time to try out new techniques, get out of their comfort zone, and not be afraid to fail. Speed-painting consists of simple quick color sketches and is an exercise that trains you to generate ideas and paint fast, and break out of your comfort zone. We round up two pro artists to tackle the same topic and create a painting in just 30-minutes! Discover how each artist interpreted the brief in the following tutorials.



Topic: A hairy creature observes a snowboarder under the rain.



 The Artist



Florian Aupetit



florianaupetit.tumblr.com Software Used: Photoshop Florian Aupetit is currently working as an art director and a 3D generalist at the Parisian studio Monsieur K. He is also currently working on a personal animated short film called Father & Son.



Artist #1 SPEED PAINTING CHALLENGE



Speed up your workflow Florian Aupetit takes on a 30-minute speed-painting challenge to demonstrate techniques that can help speed up your painting process
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Speed up your workflow with these top tips... Speed-painting is a useful tool to find a mood for an illustration, a shot for every project you’re working on, but it’s also a powerful tool to speed up your productivity. This tutorial will guide you through the speed-painting process; the time limit is based around 30-minutes and the topic will be ‘A hairy creature observes a snowboarder in the rain.’ I used to paint warm and sunny environments so when I read the topic I thought it would be a good exercise to train myself to paint something different, with an unusual color palette to break out of my comfort zone. First I will rough my main idea on a small canvas then I will block in the composition with big flat shapes and finally try to find a good balance between details and abstractions. Then I will give you some tips to help you to increase your productivity to save a couple of minutes of your time.
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Sketch your idea: The idea with this first step is to create a new document with a small size (about 800 x 500 pixels); it will be my little piece of paper where I will sketch my
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concept. White background tends to disturb me a little bit, so I immediately fill my document with a medium gray. Now I feel better I create a new layer and I start to sketch my main elements with a thin black brush. I read the topic one more time and my first idea is to put the creature on a road



(or something similar) looking at a billboard with snowboard advertising.
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Adding a first lighting direction: These two first steps have to be very quick – around two or three minutes. For me
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having a solid visual culture is really important to be efficient in choosing my lighting direction. I spend most of my free time studying several types of pictures, and because the internet is full of good things it can be a still from a movie, a photograph or an old masters painting. So here I decide to choose an overcast lighting setup to have something smooth and neutral. I zoom out to 50% and start to block in the lighting and the first composition with big flat shapes. Because of the fog due to the rain I will use dark values for my foreground and the lighter ones for the background.



PRO TIP Check your values



One method to check your values is to add a Hue & Saturation adjustment layer to desaturate your canvas, but it’s a little bit heavy to hide and unhide this layer every time you want to check. Thomas Scholes has found a quick way by using the proof colors, and by pressing the shortcut Ctrl+Y you can check your values easily. To enable this function just go to View > Proof Setup and change ‘Device to Simulate’ to ‘Working Gray – Dot Gain 20 %.’
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Blocking the composition: I want to have a spiral composition, so I have five elements to analyze; the sky, the trees, the billboard, the creature and finally the mountain background. I want to lead the eye from the creature to the billboard, so to do that I will use the treetops to help me to lead the eye to the dog. Then the head of the creature will look at the billboard to make a natural path for my eye and something on the advertising (maybe the arm of a snowboarder) will lead to the background. The elements you use to lead the eye to the area of interest don’t need to be obvious, sometimes a branch or a prop can guide your eyes where you want them to go.



The first line sketch as a foundation. Here the composition or the lighting doesn’t matter; rough the idea to fix it on the canvas



This thumbnail step is essential in the process. It will validate the painting. If you don’t like it return to step one You have to work on your composition to tell a story through your painting
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“Painting trees is a thing I have always liked, you can shape them as you want and they can support a high level of abstraction”



04



Always start with the sky: The rough part is now over, so I scale my thumbnail to the final size of 3,508 x 2,480 pixels; I go to Image > Image Size (or the shortcut Ctrl+Alt+I). I always start to paint the sky first as it quickly gives me the mood of my painting and as I said before, I choose a neutral lighting due to the bad weather.



PRO TIP Change menu colors in Photoshop



We lose a lot of time navigating through menus or looking for a filter. An efficient method is to memorize the shortcut but most of the filters don’t have a predefined shortcut. So to change that, Photoshop have an interesting option that allows you to change the menu colors to increase your productivity. You have to go to Edit > Menus… Now you can customize menus that you use frequently like filters, image transformations or view option.



I use the Free Lasso tool to select the sky area then I pick a dark cool gray and with a big brush I paint my foreground sky. Because of the strong aerial perspective I choose a lighter gray to paint the background. Then I blend these two parts with the Smudge tool, and I set the strength very low, between 5 and 10, with a large scattering brush (you can activate the scattering in the Brush panel).
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Work on the biggest shapes: Painting trees is a thing I have always liked, you can shape them as you want and they can support a high level of abstraction. So usually in my speed-paintings I don’t paint details; if I just want to have a feeling of a tree, it doesn’t matter if the tree doesn’t have branches or leaves. If you can convince someone that this big shape is a tree it means that you have more time to spend painting on another element. The two most important things to always keep in mind when you are painting are the values and the edges. Sometimes you have to keep a contrast between two shapes with hard edges and sometimes with blurry edges; you have to find the right balance. So I choose a dark desaturated green for my foreground and a light desaturated blue for the trees lost in the fog, but I try to keep the hard edges in my foreground trees.



Immediately starting with the sky can give the mood and lighting we want Here the biggest shapes are the trees, but it could be a building, the ground or a character in a different project
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Create the road: By using the free Lasso tool I define the shape of the road, and by pressing the Alt key I can switch from the free Lasso tool to the Polygonal Lasso. The process is almost the same as the trees; I keep hard edges for the foreground and smooth edges in the fog. I also start to think of the reflections of the trees in the water on the ground, and I paint two large dark areas on the edges of the road and a brighter one in the center. I don’t carry lots of detail to the road in the far distance because I know the fog and some props will mask a large part of it.
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Creation of the props: I start with the billboard because it’s one of my main elements. Because of the time restraints it will be very basic, so I use vector shapes for the two snowboarders and I type the title SKI SCHOOL 50 KM. Maybe the ski station is at the top of the mountains in the distance, for me it’s another component of the story behind the painting. I distort the reflection of the billboard on the ground with hard curves because the water is not equally distributed on the road. Then I add the streetlights in the foreground and roughly in the background and on the mountain. Finally I add two cars to add more life on the road.
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I create a layer at the top of this group to add the lights glow and the scattering of the light through the fog in the background. To do that I use a big Soft brush with the color of the element I choose to enhance with this light.
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Rain and reflections: Because of the time limit I can’t paint the rain by hand,



so I will use the ‘usual’ noise tricks. I create a new layer and I fill it with pure black and I apply a noise filter with an amount of 400%. Then I have to blur it so I go to Filter > Blur > Gaussian Blur and I choose a radius of 0.5 pixels. To see the effect of the rain I switch my layer to Screen mode and now I can add the rain direction, so I apply a Motion Blur filter with a distance of 35 pixels.
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When the waterdrops fall through the light of the streetlights or in front of the billboard they are lighter. So I create a Levels Adjustment layer and I clip it on my rain layer. I increase the black input level and decrease the whites – now my rain is brighter. I fill the layer mask of the adjustment layer with black and I paint the lit part of my painting with a big white Soft brush.
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Adding the creature: I’m more comfortable with landscape or inanimate objects, so I tend to paint the character at the end of my process. At this point the time is almost done so I choose a basic design for the creature; it will be just a red or orange hairball. But it will be a warm color to contrast with the bluish environment. I use a scattering brush to quickly have the shape of the creature. I think it’s a kind of strange dog and it has probably been walking a long time in the rain, so I add dirt and mud to his legs and at the bottom of his fur. I also add little reflection specular points due to the water that flows over his fur.
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The final touches: The painting is almost done so it’s time for the ‘polish’ step. My painting is a little bit flat so I start with a Brightness and Contrast adjustment layer to add contrast. Then I use a Vibrance adjustment layer (Layer > New Adjustment Layer > Vibrance) and increase the vibrance to 50%.



Another thing I like to use is the Camera Raw filter (only available with the Photoshop CC) I can quickly change Exposure, White Balance, Sharpen and so on. A good way to save your time is to save presets of these settings! The last thing I do is to add a layer with noise at the top of my layer stack as it will unify the whole painting. Voilà! Now you know my speed-painting process, as I said I forget details and try to paint a global feeling. If you practice speed-painting everyday, this is a good tool to speed up your productivity, so keep working and don’t forget to tell stories with your paintings!



Using the double function of the Lasso tool can speed up your productivity Add props to your painting to help the viewer to understand the story behind the picture To create this rain quickly refer to the steps and create a script for future use Don’t spend a lot of time finding a good design for the character; use your time to work on his integration
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 The Artist



Florian Aupetit



florianaupetit.tumblr.com



 The Artist



Ilya Dykov



artstation.com/artist/dykov Software Used: Photoshop Ilya Dykov is a freelance 2D artist.



Artist #2 SPEED PAINTING CHALLENGE



Improve your painting practice



Discover Ilya Dykov’s thought process when interpreting a brief as he guides you through his speed-painting workflow
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Learn how to create a narrative speed-painting... In this tutorial I want to share some principles that can make a picture look cool. I will tell you about a few techniques and software features but this image doesn’t rely on them. The understanding of technical issues comes with experience; therefore here I’d like to talk about the thought process. You must ask yourself the right questions and answer them with your art.



“Hotkeys also help me to have some free working space”
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Preparing software and workspace: This might be unnecessary for most artists, but I like to feel comfortable while working. The first thing I’ve done in Photoshop is reassign some hotkeys to other tools as it can save a lot of time. My working zone lies in the WASD-keys area. Hotkeys also help me to have some free working space to put canvas in there. I have blocks with layers, brush settings and history hidden. I use a ColdWarm plug-in to pick up cold and warm shades for my color.
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Fast linear sketch: I’m not a fan of line-art but to start with a colored splash is pretty risky. It might bring more emotion to the sketch, but after all if you don’t see key elements of the future sketch, you’ll suffer a lot with making endless corrections to the silhouettes. So I start with a linear sketch – it shouldn’t take longer than 2-3 minutes just to make the main idea clear. According to the brief it’s a hairy creature watching a snowboarder in the rain.
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Basic color: So I’m showing a snowboarder in a thick forest in the dark, the core colors are cold (and scary). Not to forget that the guy is our main character, so he must be in contrast to the environment. There are plenty of ways to do that ‒ tone, forms, scale



Here you can see how hotkeys are reassigned The initial sketch
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and color can help us with that. This is why our snowboarder is wearing an orange coat and a yellow helmet, so he won’t blend in with any surrounding trees. He’s also too skinny to ever fight our boogie man!
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Composition: Actually, it is better to think about composition in the first step and that’s my mistake which I’m paying for in time. I often check my composition with the Crop Tool (referring to the Golden Spiral regime). Now I have checked the composition, I’m painting the snow/rain in this spiral direction. To finish the spiral, I put the broken branch at the top of the composition (considering that the creature is bigger than the human).
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Grounds and perspective: When you are busy and against the clock with your sketch don’t forget about building perspective through layers. The easiest way to check if everything looks correct is to switch to black-and-white, so that your perception is not overwhelmed with color. Photoshop offers lots of ways to do that, the most popular is to make a fully black layer and set it to Color in layer mode. But recently I’ve found something way better ‒ convert your picture into Dot Grain 20% and voila.
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PRO TIP About brushes



For brushstrokes I prefer the first brush, it has a nice oval shape and interesting noise, which gives a cool texture at a medium resolution. I like to use the mixed brush for textures and slightly blurred line. This I use while finishing my work. For color mixing and blur I use the Smudge tool and basic brushes.
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PRO TIP Practice



The more sketches you draw the more skilled you become. Use multiple tools that you’ve never dealt with before. Photobashing, 3D, various simulations and so on will do.



My guess, you often miss the transformation hotkey (Ctrl+T) and press Ctrl+Y instead, converting it all to CMYK. Annoying, right? I was rescued once and I’ll save you now! Go to View > Proof setup > Custom and choose Dot Grain 20%. The huge positive of this method is the possibility to collect and use colors from RGB while drawing in black-and-white. This may sound too complicated, but try it once and you’ll love it. Grounds and perspective (part 2): Remember that air has its own density; use it if you want your picture to look realistic. For example, you can differentiate trees between the background, middle distance and foreground by how blurry the area is; the blurrier it is the greater the distance the tree is from the viewer.
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Atmosphere: Atmosphere is what gives the picture its mood, and the story in your head will help influence it all. Each time you make a sketch you should ask yourself: who, what, and why? In this sketch you can see moody cold colors, grumpy rainy/snowy weather (typical for this



season in Belarus, by the way), a wounded tree, broken branches (slightly hinting on the size of the creature), maybe some leftovers of its food, details of scenery and so on. Also there is of course, our ridiculously brave idiot-snowboarder who takes a selfie instead of running as fast as possible from the place. If you put all those elements into right proportion the picture will be realistic and moving. It has nothing to do with your style.



elements to hint at what has happened or will happen in the image.



Photorealism is just a manner, not a proof of veracity. Your task is to drive the imagination of the viewer to the same idea you are trying to put across. You can succeed with it by using a good balance of the elements. The trick is to use the



Check your values and perspective in black-and-white



Adding in the base color palette Checking the composition and adding elements to lead the viewer’s eye around the image



Using different elements to create and enhance the atmosphere 87
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Atmosphere (part 2): Remember that there are no plain surfaces in this world. Snow is not plain; it’s a pile of random snowdrifts that are reasoned by the scenery. The snowboarder didn’t fly over there, so there will be his footprints and disturbances. The same about the condition of the objects. The broken branches show the power of the creature and underline the snowboarder’s stupidity. This tree was in contact with something huge and dangerous: get into gear, put your board back on and get the hell out of there! The logic behind every detail of the picture is the core value for me.
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Take a break: If you want to take your painting further, have a rest before you start the detailing process. Check if your sketch works after a couple of hours or even a day. You may notice some bugs and find a way to fix them at this stage. You may show it to a friend to receive some feedback and to understand if people feel the same way as you do. For instance, my feeling of anxiety is that the snowboarder has disappeared at this step. So I’m adjusting the scale of the creature and the character. For this occasion, the three-point perspective with a view from the bottom up, where the bulk of the sky would be covered by the creature fits just fine.



Extra details to push the atmosphere and narrative further Take time away from your image to get a fresh perspective
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 The Artist



Ilya Dykov



artstation.com/artist/dykov
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 The Artist



Simon Dominic painterly.co.uk



Software Used: Photoshop Simon Dominic is a selftaught illustrator who specializes in fantasy and horror themes. For the past three years he has worked mainly on illustrations for social gaming projects and collectible card games. Simon uses Painter and a little bit of ArtRage.



Discover Painter 2015 Simon Dominic demonstrates how to paint a fantasy scene to show-off the newest functions of Painter 2015, including Perspective Guides and Perspective Guided Strokes
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Master Painter 2015 with the following top tips... For this workshop I’m going with a fantasy theme to demonstrate some of the new functions of Painter 2015 as well as the tried and trusted brush engine. One of the features I want to demonstrate is the Perspective Guides and Perspective Guided Strokes. If you’re anything like me then painting accurate perspective can be a chore, so a tool like this comes in handy. To demonstrate the perspective functions I will be painting some industrial structures embedded high above the viewer and partly hidden by the clouds. The premise of the image is that our main character has fallen asleep while dozing in the sun and awakened into a dream landscape. Above him towers the ancient corpse of a creature into which the land’s inhabitants have built a series of strange, rectangular edifices. The scenario offers plenty of opportunity to represent natural textures such as rock, sand, vegetation and other foliage, areas in which Painter’s brush engine really comes into its own. I want to put Painter’s new Particle Brushes to good use so I will be employing them as a quick and easy way to create a vegetation base on which details can be later added. Particle brushes are great for producing exotic, abstract designs ‘right out of the box’, but with a bit of tweaking they can also be of benefit in more realistic pieces. Another feature I make use of is Brush Jitter and Jitter Smoothing. Jitter can be applied to many brush functions including size, position, grain and color, and by doing so you can impart an effective natural media look to your work without trying too hard.



01



Filling the canvas: A blank canvas can be intimidating, so I quickly fill it with a basic color rough. I use a roughly-hewn Captured brush set on Grainy Soft Cover with moderate Grain. I apply small Jitter settings with medium Smoothness for Grain and Size in order to give a more painterly feel to the strokes. I also set the Hue aspect of the Color Variability control to around 4% for a more natural effect. Using this brush I block in the main features – the ancient creature, the dreaming character and the background. I suggest distance by use of desaturated colors. My canvas at this point is 1,600 pixels tall.



02



Introducing perspective: In order to block in the artificial constructs built into the corpse of the creature, I utilize the Perspective Guides. I load the 3 Point Worm’s Eye View and modify it just slightly so it fits the viewpoint I wish to communicate. After adjusting the grid spacing and line display I toggle ON the Perspective Guided Strokes



The color rough helps define your palette and lays out place-holders for your main elements The Perspective Guides are a handy way of maintaining consistency when dealing with planar objects such as buildings
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option and rough in some buildings high on the creature’s torso and head. At this stage there’s no need for detail, what is important is to establish a perspective viewpoint that makes the creature look towering and imposing.
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Working in color: A quick way of adding to and strengthening the color palette at this early stage is to use Layers. I create a Colorize layer, set it to a medium opacity and with my default captured brush; I bolster the colors to suit the image’s mood. I want a general, bluish ambient light to be offset by a relatively bright, saturated sunset, so I dab those colors onto the layer and drop it to the canvas. I then reinforce the strong areas of sunlight with brighter, pinkish strokes. As well as creating some dynamic lighting this will help balance the image. Without that balance the human character would pull the composition out of kilter.



04



Early adjustments: I use the Brightness /Contrast controls to enhance the contrast of the image. Ticking the Preview checkbox allows me to see the results on the canvas before I commit. I also want to do some early highlighting of key areas such as the character’s head. I could use layers but another method is Stroke Attributes. I check the tickbox in the Stroke Attributes panel and select Overlay as the Merge Mode on low Opacity. This enables me to use my default brush as a wash. Note that by setting Merge Mode to Default and reducing the Bleed I can turn my brush into a Photoshop style wash brush that builds up on multiple strokes.
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A bit of grunge: A great way of suggesting distance on a flat plane is to use the Squeeze function on a brush combined with a bit of Stroke Jitter. Using a captured brush I set Squeeze to a very low value in the Angle panel (which, counter-intuitively, squeezes the brush aspect heavily) and an Angle of 0, and add a bit of Stroke Jitter. I constrain movement to the horizontal plane by holding down Shift and add a bit of grunge on the distant sand. Now I increase the Squeeze to expand the brush vertically and use it to add grunge nearer the viewer.
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Painting the old guy: My main character is the dreamer; an old guy who has fallen asleep in the sun and is dreaming of this strange, strange land. In our dreams we often appear to be different and our bodies distorted,
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so I’m going to depict the old guy in an almost caricature style. I reference half a dozen photos to help me. I also want to show that he’s not part of this world



Establish the color scheme at an early stage to help with composition Use Stroke Attributes as a method of implementing effects using your brushes The Squeeze function can be used to align a brush with a plane, or with the direction of movement using the Direction Expression Use unexpected lighting effects to communicate the background story and create a high-impact character
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and I can do this by using a radically different light source and ambient shading. I decide that because he’s fallen asleep sun-bathing he will be lit by the invisible sun of his real world. I resize my canvas to 5,000 pixels vertically and, using my default brush, I add rough detail to his head.
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Positioning the main character: In the same way as the lighting can enhance the story, so can the placement of your characters on the canvas. Here I’ve deliberately set the old guy near to the border of the painting with his foot out of frame. This is somewhat non-standard in compositional terms but I feel it reinforces the idea that he is not really physically present and that he is an ephemeral visitor to this place. I bear in mind that his positioning will need to be offset later by a more heightened contrast between his form and the background, to avoid him being overlooked.
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The Particle Brush: The Particle Brush allows you to create a variety of effects such as smoke, fire and natural textures. Here I’m using it to rough in the vegetation close to the viewer. I capture a Flow Map in high-contrast black-and-white, which is a photo I took of woodland vegetation. I select a Flow Particle Brush and link it at 100% to the Flow Map using the Flow Map slider on the Particles – General panel. By playing around with the settings I can quickly create a messy foliage texture that will form the base for a number of alien plants.



09



Perspective Detailing: I activate the perspective grid using the Perspective



PRO TIP



Be honest



We’ve all been in the situation where we’re ploughing ahead on a piece and it’s not working out. We see the problems but the more we fiddle and tweak the worse they get. Eventually we kid ourselves that there are no problems and submit the piece for review, or post it on a forum, only to get back criticism that if we’d been honest with ourselves we’d known was coming. Don’t be afraid to say “Stuff it!” and start over, or blot out half your image and re-do it from scratch. This is part of the process, not an admission of failure, and you will always benefit from it in the end.
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Guides icon and load my preset 3-point arrangement. I zoom in to 100% and with my default brush constrained with Perspective Guided Strokes, I add some detail to the industrial constructions that are built into the corpse of the ancient creature. I color pick tones from the canvas to make sure the general value range accords with the distant haze and fog, but I don’t have to worry too much as later I’ll tidy up with Darken or Lighten layers. Occasionally I unconstrain the brush with the Perspective Guided Strokes toggle in order to include angles and effect block shading.
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Let’s have some bots: I think the piece would benefit from the addition of some secondary characters. Being that the buildings in the background are somewhat basic and



PRO TIP



Get organized



It might seem contrary to the artistic temperament but organizing your workspace is a stage of the creative process not to be overlooked. It’s well worth spending time experimenting with the best layouts for your panels and menus and creating bespoke content suited to your own workflow. Don’t just download and use a workspace because you’ve seen someone else use it. Bear in mind that you’ll be engaging for hours at a time with your software and thus even the smallest niggle can snowball into a frustrating distraction. Illustrating is hard enough at the best of times so do yourself a favor and make sure your interface works for you and not against you.



The character’s peripheral positioning is offset by a high-impact color contrast Scribble with Flow Particles to create a textured base for the alien vegetation



Perspective Guided Strokes allow the rapid addition of industrial detail without having to worry about your angles being out of kilter Keep the secondary characters simple and unobtrusive so they don’t detract from the main focus 97
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functional I’ve decided to go with a few bots that possess similar attributes. I use the Oval Selection tool on a new layer to create simple constrained shapes, which I then color with my basic brush. It’s important to bear in mind the ambient lighting in order to give the impression that the bots are physically present in the landscape, unlike the astral projection of the dreaming character. Therefore I add hints of sky and sand reflection. I duplicate my first bot’s body for the second and third bots.
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Working with detail: I zoom in to 150% to add fine detail to the old man. I use my default brush to refine his skin texture and a Lighten layer to add subtle reflection in the lenses of his glasses. I merge the Lighten layer with the main layer when I’ve finished the reflections. I apply blending using a brush that is basically the same as my default captured brush, except the Resaturation is 0% and the Bleed 100% with Expression Pressure. With its opacity controlled by pressure I also get a lot of control over the magnitude of the blending, which is important
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PRO TIP



Use reference



Referencing doesn’t have to mean slavishly copying. Indeed, it shouldn’t mean that at all. Reference is an important tool that can be used to improve all aspects of your work. You might want to reference a character’s pose, or the color tones in skin, or the gnarly texture on the bark of a tree. The key to good referencing is to take from it the essence of what you’re trying to achieve, rather than making a mechanical copy that may look nice on the page but won’t help much in improving your broader skill set.
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as too much blending will destroy the painterly effect and make the result look overly digital.
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Texturing the environment: One of the key things to remember when painting environments is the nature of your light-source and how it interacts with the objects it encounters. Here we have the relatively strong,



salmon-pink light of the sunset emanating from outside the right-most border. Most of the rest of the landscape is not lit directly by the sun, and therefore the effect of the ambient light starts to take over. This light is diffused, relatively dim and desaturated, coming as it does from the cloud



Blending should be used sparingly, for subtle color transition rather than to define form Contrasting direct light with ambient light can lend an air of realism to your image
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and fog directly above. Thus we have high-color, bright light producing deep shadow, in contrast with low intensity, bluish light producing diffuse areas of shadow.



13



Reflecting on reflections: Every object reflects some light, or else you wouldn’t be able to see any of its detail, and some will reflect enough light to emulate the properties of a mirror. In this image we have two areas of strong reflection – the pools of water and the sand. Because we are viewing the beach from a shallow angle a fair proportion of the light falling on the water surface is reflected into our eyes. Less so for the sand but some of the wet areas are reflective enough to mirror a hint of the pink sunset light. I apply the lighting with my default brush, sometimes constraining to the horizontal with Shift, and I also use my squeezed grunge brush to add detailed texture.
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Rendering fractal surfaces: Irregular, natural surfaces are sometimes tricky to paint. Not so much technically, rather because the human brain doesn’t do random well. Our brains have evolved to find patterns in things and often I find I’m unconsciously painting repetitive elements into my work. One way to get around this is to use reference as a springboard. Here, I reference a variety of photos of cliffs to get myself started. After a while my mind seems to settle down and I loosen up, at which point I can forget about the references and carry on painting from my imagination. Unless I think about it too hard, in which case it’s back to the reference...
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Finishing off: I drop my layers to the canvas. I am asked by the guys at 3dtotal to add a little extra to the top of the image to fit the required format. This is pretty straightforward and I color-pick from the canvas to match the existing palette. I then activate the Virtual Grid which causes a grid overlay to divide the image into several user-defined sections. This is normally used for direct referencing but I use it for checking the image methodically at 100% and making sure that I haven’t missed any portions. Last of all I use a couple of the options from the Tonal Control menu to adjust the contrast and color balance of the whole piece.



Areas of reflected light help bring cohesion to your image, if they are not then overused Using reference initially helps overcome any unconscious tendency to produce repetitive, ‘artificial’ patterns in what should be natural, random textures A non-standard use of the Virtual Grid is to divide the image into sections in order to methodically check the detail at full zoom



 The Artist



Simon Dominic painterly.co.uk



 Get the Renderpower of 3000 CPUs into your Desktop Image by Kerim Ekal (www.kerimekal.com)



Rendered at RebusFarm



35€ Free Trial



RebusFarm 2.0 is your next generation render technology to harness the power of 3 000 CPUs. This means an easier workﬂow, faster live monitoring and safer realtime communication. Do you want to know more ?



Only for new registrants.



Bonus Coupon Code: 3DT-RF-5Q8897JX



www.rebusfarm.net



 REE F S U L P VIDEO NG! TRAINI



Subscribe today and receive 4 free issues! “A great source of inspiration and tips on how to improve your skills and speed up your painting process. Besides very detailed step-by-step tutorials, 2dartist magazine will also ensure there are a large variety of topics covered as well.” - Blaz Porenta, illustrator
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 The Artist



Rafa ArSen



behance.net/rafaarsen Software Used: Photoshop Rafa ArSen was born in Córdoba City, Spain. He studied Illustration and graphic design in art school and works as a graphic designer and illustrator.



Create a pin-up illustration



Using standard Photoshop brushes and Blending layers, Rafa ArSen demonstrates how to paint a stylized pin-up girl
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Rafa ArSen shares top techniques to paint the perfect pin-up girl... In this tutorial, I will show you how to create a pin-up style female character, emphasizing sensuality through the pose, expression and shades. In this case the character is a lab assistant. I will use standard Photoshop brushes and blending layers.
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Sketching and concept: At this stage we are looking for our character. For this step you can use references to find your pose, in my case I haven’t used one, as I like working without direct references whenever I can. I build a basic structure seeking out the proportions, without worrying too much about the quality of the drawing.



To correct possible mistakes it is very useful to flip the image horizontally and vertically to see it from different viewpoints. It’s good to do several poses to find the best one. In this step in general I look for sensations, movement, and composition. The result is a simple drawing and a little rough that helps me visualize the character and form. I try different ideas of the pose of the hands and the glasses design; it is easier not having to devote much time to a very elaborate line.
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Clean up and define: When we have the final character sketch, it’s time to clean up the lines and define each area. In this case I’m not seeking a finished line; I’m just interested in a guide for the painting stage. In the end, the line will disappear almost completely.



Cleaning up the sketch can be done in several ways, the most common is to add another layer on top of the sketch layer and draw a new line over the rough line. I personally clean up the shape with the Eraser tool and repaint zone by zone defining and cleaning the line while trying to keep a uniform size and hue. In this step I add details such as the identification card in a pocket of her uniform or the texture of the gloves. To enhance the pin-up style pose, dress, hairstyle, and expression, everything must be a touch suggestive and sexy without being overly rude. Sketches of the character The clean sketch 105
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Flat color: In this step I choose the base colors and paint each zone in different layers; one for the skin, hair, gloves and so on. This way I can work separately in each area without changing the adjoining. It is also helpful to change the color of each part separately so that the initial color is not definitive; for example, I can change the hair color simply by modifying the layer containing hair. I paint each part with a flat color then add the volumes. Filling the background with a gray helps to make sure no areas are missed when coloring. I use the layer order to arrange the pieces so that the skin, for example, is below the layer where the clothing is painted; all this makes working more comfortable for the next steps where I start to add volumes and lights. It is important to paint below the line and make sure there are no unpainted gaps between each zone.
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Paint skin: Once I have all the different colored areas separated into layers, I begin to give them volume. I like to start with the face; I create a new layer above the layer of skin and frame as a Clipping Mask, so I am only painting on the skin layer. Here I find a direction of light to build volumes. In this case the light comes from the right side of the image, so she is illuminated from the right side, and the left side is in shadow. I add light areas, and then select a darker tone than the base color for the areas in more shadow, such as under the chin areas, the eye area and the shadows of the clothes and hair. I will use the
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light areas applied to the skin as a guide to paint other parts of the illustrations. For the eyes and teeth I create a layer on top of both so you can work these independent elements. All these layers below the layer containing the line are set to Multiply mode.



05



Painting the rest: As in the previous step I create a layer on top of each element of the character to color, and I’m giving volume by referencing the direction of the light applied to the skin, using darker and lighter shades as the base tone to create volumes. The main light of the character comes from the right side of the image and to create contrast in the darker areas, I add a second light affect to the character (not so directly this time). This light comes a little from behind so that the character is slightly edge lit; this lighting creates a good volume effect. At this stage I focus on the direction of the light and build the different volumes of clothing, gloves and hair, but without going too deeply into wrinkles or lots of colors. I look for balance in the overall lighting scheme.



The first color step; organize your layers and paint below the line Giving volume to the face and the color palette for the skin tones First volumes and direction of light
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“It is important to keep in mind the texture of the material we want to achieve; if we overuse these brushes the result will be a very smooth overall texture”



06



Color retouching: Right now I’m back to a white background to check all areas are colored and that no areas have been missed on the darker background when filling in. Once this step is done I do a general touch of color correction to achieve a more uniform color tone overall. For this I use a Color Balance layer, so that the change applies to all layers remaining below this layer, this way we don’t have to flatten the layers or make individual adjustments. Also I use a Selective Color adjustment layer that lets you individually retouch each color group. I tone down the orange hue of the skin and create a more harmonious color palette; areas such as the uniform that were previously completely gray now contain subtle coloration that blends with the rest.
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Defining volumes: At this point I am trying to define the volumes of
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each part; for this I turn off the layers of color adjustments applied in the previous step to work with the original color in volumes. This allows me to use the Color Picker tool to define volumes, correcting and improving each area. I use a blurred brush for large areas and a Hard brush to define edges. It is important to keep in mind the texture of the material we want to achieve; if we overuse these brushes the result will be a very smooth overall texture. In the case of clothing I use the Hard brush for the shadows and to define the lights further to get a more fabric-like textured edge. Use the same pattern for different areas to define the volumes and textures. For areas such as the glasses and the flask create a new layer and paint white, filling it completely. You can then alter the opacity revealing what lies behind. Areas that are receiving more white light will be more opaque.
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Volume and details: I continue the previous step by setting the volume of each of the areas, adding more colors, and emphasizing areas where light falls in a more



direct way. I do all these steps taking into account the texture of the material that we are representing (hair, clothing, rubber and so on). I add a new layer to test out some effects. By adding another layer I can experiment and manipulate the previous steps without fear of losing the volume I have already achieved. At this point I add reddish-looking tones for the blush on the cheeks and the hues on the lips. I make another layer above all other layers set to Soft Light mode and subtly, with a Soft brush, apply this color smoothly around the eyes and chest, and then more visibly on the cheeks, nose and lips. For the eyes I create a layer above the lineart and paint the colored area of the eye leaving the top shadow as it is.



Result after retouching the color Volumes defined in uniform Final volume and first details
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Last clean of the lineart: In this step I merge all layers down so that I am left with only two layers, the character and background. Then I start to clean up the excess lineart that can protrude outside the color illustration, and for the areas inside the lineart I create a new layer and paint over the lines thinning or removing them. I’m not looking for a perfectly clean result, the line is still seen in some areas and for others it’s completely gone; I like the dirty effect achieved. I normally put more focus into the face as it is the focal point of the image, leaving the other areas a little rough helps draw attention to the face as it’s more detailed. For this illustration I create a neutral background to accompany the lighting by filling it with a medium gray tone and illuminating the areas that mark the direction of light.



10



Final step: For this last step I merge the character layer with the background and apply an effect that I use regularly. I apply a Diffuse Glow over the image with soft parameters to create a glowing effect on the whole picture. I personally like this as I feel it helps harmonize the image, and adds warmth and depth. Once this is done I start to make the final touches to the overall color illustration. For this I use the Color Balance tool again to harmonize hues and find a more correct overall tone. As a final step I add a few small white stokes with a small Hard brush, to create a reflection effect in the middle area of the lips to give them a wet look. I apply these little white touches to areas where there should be a reflection of strong light, such as hardcover glasses or the instrument she is holding. I apply some more reflections to her hair and the illustration is finished.



Cleaning up the lineart Finished illustration
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 The Artist



Rafa ArSen



behance.net/rafaarsen



 3DTOTALPUBLISHING



The Beginner’s Guide series is back with a clear and comprehensive look at working in Adobe Photoshop Elements. In this sequel to the best-selling Beginner's Guide to Digital Painting in Photoshop book, a new set of talented artists break down the best and simplest techniques for creating amazing artwork in Photoshop Elements. This fundamental guide offers easy-to-follow steps that guide you through setting up your software, working with brushes and basic art theory, as well as chapters on creating certain artistic styles. With a simplified interface and fewer variable parameters to learn than its big brother, Photoshop, Photoshop Elements is an ideal tool for any artist’s first digital adventure. This book is therefore a perfect resource for: • Newcomers to Photoshop and digital painting • Artists looking to switch from a traditional medium • Lecturers and students teaching/studying digital art courses • Hobbyists who want to learn useful tips



Available from www.3dtotal.com/shop



 The Artist



Amin Faramarzeyan



artstation.com/artist/ aminfara Software Used: Photoshop



An illustrator and art director who loves visual arts. Amin has been working in the advertising field for more than 10 years. Projects he’s worked on include 2D and 3D animation for videogames.



Master stylized creations



Discover the process Amin Faramarzeyan used to create his illustration Music Makers. From sketching and using shapes, to lighting and color, Amin shares top techniques to help you create a cool stylized image
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Discover the techniques behind Amin’s stylized image... I’m going to take you through my process, step-by-step, so that you can closely see how I approach my illustrations. You will need to at least have the basic understanding of drawing, shape, form, color and other fundamentals so that we can focus on a project that will take 2 to 3 days to finish, which will hopefully leave you with a smile on your face. The following steps are targeted towards the Intermediate and above artists; it could also be useful for the beginners if they want to see how I construct an image. Additionally, I’m going to do my best to cover everything from sketching, to shapes, to working towards light and shadow, color, and then finalizing the end result. Please be aware that I won’t be able to get into too much depth, and explain things like how to come up with the best composition or design, only because I’d have to be more general when describing the steps. You should have a good understanding of Adobe Photoshop or any other layer-based 2D software. Don’t worry about brushes or add-on packs, because we won’t be relying on them that much in this tutorial. For the most part, we will be relying on Dodge and Burn, Color Balance, Hue/Saturation, and Curves. You should be able to collect one thing or two from this tutorial, but anyways let’s get started; it’s going to be awesome!



01



Initial sketch stage: Sketching is the beginning for many artists. Basically we have to do a couple of rough thumbnails at the very beginning to come up with our initial idea, while having the main story or goal in our mind. This is the most important part of the whole process, but it can also be the most fun because you can play around with your thoughts and let your creativity take over. I try not to think about how hard or easy my illustrations will be execution-wise, but just focus on having fun with the ideas I can come up with at this stage. I also tend to work in my sketchbook because I love the feeling of it. I would recommend the same to you as well, but please use whatever you’re most comfortable with. After you’ve got a solid sketch/plan, we can move on to the next stage.



02



Rough sketch stage: Before you’ve arrived at this stage, I hope you have



PRO TIP Study the shape concept



Shapes are very important factors in making or breaking a picture. They make great silhouettes and form, and they are essential to your composition and layout. Playing with their proportions can add great interest to your image. Try to find appealing shapes in nature, like stones and trees, and use them in your work. Nature is the ultimate reference. Shapes are usually flat and 2D, so the challenge is to turn them into interesting 3D forms, which is possible by practicing drawing in 3D to gain a good understanding of form in 3D. Give it a try!



chosen a sketch that you love and would work very well with your idea. The best thing to do is to try as many different compositions and poses as possible before committing to anything final. The



The initial sketch gives clues about where we’re going and what we will be committing to later on
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main reason why this is important is because you might find yourself spending 2 to 3 days painting something that doesn’t have a great composition or a clear pose ‒ keeping the principles as second nature when approaching a new illustration is very important. At this stage, my sketch is still pretty rough. I like to keep my drawings loose so that I can keep making changes as I move forward with it. This saves some creative energy from being burned in the sometimes boring and time consuming process of painting. If you don’t know it by now, the painting process can be hard sometimes!
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Starting the shapes: I use an Overlay sketch layer for my overall shapes indication. I rely a lot on my imagination because I enjoy coming up with some new elements. I start to create shapes using the Lasso tool, starting from large shapes and gradually finishing with smaller shapes. I try to design interesting shapes when I use the Lasso tool, and since I’m a big fan of sharp angles, I keep everything pretty sharp. As you can see, my shapes do not follow the exact contours of my sketches, and sometimes I change the pose a little bit. I move parts around – like his head in this case – to get a better and hopefully more natural pose for the character. Place the
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PRO TIP The importance of learning



You’ve probably heard this so many times, but so many things go back to the foundations of painting and drawing, like anatomy, perspective, design, composition, color, light, and so on. There is always room to learn even if we think we know these things and we have a great deal of understanding of them. One thing that good mentors will teach us is to keep your heart and mind open, and never put a stop to your learning. Always observe and study everything, from people to nature to man-made objects carefully, there are so many stories laid in these subjects.



Transform pivot in the right places, like the joint of the elbow, and rotate the shape to get the desired angle and pose (almost like a little rig, it’s fun!)
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Shape stage continued: Once I have my initial shapes, I start to manage my layers in groups, like the Tree group, or the Main Character group. Since my process is very layerdependent, I recommend that you keep your layers a little organized from the start, but you don’t need to go overboard with it like naming them all. Putting them in groups is probably a good idea since we are looking to create 150+ layers ‒ so let’s have a little bit of planning in mind.



When I create my shapes, sometimes I fill them with shades of gray, and sometimes with a rough idea of local colors like I’ve done in this stage.



More refined sketch. Move on from this stage, which is rough but descriptive, to making shapes and shading Starting the shapes, all in separate layers so they can be found them later on for shading/color adjustments Continuing with the shapes while refining the designs a little bit using the Lasso or Path tool
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I also try to make them visually separated by changing their value or shifting their hues. When you have the layers in separated groups, you can always come back to adjust them since we’re working in a non-linear workflow.



05



“Simplicity is the key in every aspect of art; so if you add too many light sources, you might end up with a chaotic looking image”



Finishing the shapes: Alright, if you’re still with me then you’re probably crazy like me! Yes you have to finish all the shapes, from big to small, at this stage so that you have a clear image that communicates only through shapes.



need to determine our light source and it’s direction. Is it a hard light or soft light? In this case, I choose a soft light. Our scene is set in the middle of the night so I was thinking to have a dominant key light source.



This stage will be the most time consuming part of the whole process. You’ll find that I’ve neglected the details like the eyes for the kid characters, or the fingers on the main character’s right hand. You got it, it’s time to take a break and think about why you are doing this in general! So if you still believe in what you are working on then grab a cup of tea, come back and finish the rest of the shapes, you don’t need to finish all of them just enough for the whole image to lead you to the next step. It’s totally okay to cross stages at this point.



As they say, simplicity is the key in every aspect of art; so if you add too many light sources, you might end up with a chaotic looking image. Think of your focal points and value distributions. Light effects values and colors so always try to study it in nature.
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Starting the shades: We move to the shading stage, finally. In this stage we have to focus on light and shadow. Basically we
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First I start with my darks, and then finish with my lights. I almost always use Dodge and Burn; try to play with highlights, mid tones and shadows while you are using this amazing tool.
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Shade stage continued: In this example I tried to get a better understanding of my focal points (his face being the main one). I also worked more on my shadow and lights.



In case you didn’t know, we have two types of shadows: core shadows and cast shadows. Core shadows are the ones that describe the form, and cast shadows are shadows that are cast by one object onto another. While you apply darks and lights you should always think about this concept. Cast shadows can be soft and you can see an example of that on the top right of the image. There is an occlusion pass as well which adds a lot to your work and makes it look 3D. To achieve the occlusion effect, try painting soft dark shades wherever two shapes are intersecting. This stage is usually fun because you get to see your image gradually come together.



Shapes finished, going from big to small. Leave some other ones for later so the process stays fun Start the shading, and use the Dodge and Burn tool to sculpt the forms. Try dealing with shadows first More shading, and dealing with reflective surfaces, such as the pots
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“Whenever you feel that your colors look dirty or dull, try to add saturation to them ‒ shadows have colors too”



08



Shade stage finished: If you continue adding the shadows and lights for all of the layers or parts, you should have something that looks kind of 3D, but still looks like a disaster. It’s mainly because of the lack of harmony between colors and some of the values. It’s extra important to be able to troubleshoot your work. As artists, we should be able to look back and judge things objectively. Think that it has to be awesome. Think that something is missing. Think about what can make this better. Think, are you an illustrator?! I think you should be very direct with yourself and point out the problems. If you need to take a break and come back to see the problems, then do it. I feel that overall my image is working and if I fix certain colors and values I will be in good shape.
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Colors and adjustments: This is when you start to see a glimmer of light shining at the end of the tunnel. You spent so much time so far, and you like this image, the two of you became friends. Although this is a great feeling, try to get a second opinion at this stage. If you are lucky someone else should feel the same way too, and this can show whether you were successful or not. At this stage, I use a lot of Curves and Color Balance adjustments to get the colors and values that I want. I always use Color Balance or Hue and Saturation when changing colors because they have great flexibility. Be aware that shifting hues can change the values, so always check your image in black-andwhite to see how all of the values work together. I finish coloring and add a blue tone to the image.
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Finished rendered image: I usually merge all of the layers together and treat the image as one flat layer. I add small details using normal brushes for highlights and



tiny ropes and so on. I try to push the colors and contrast by using Curves. My main goal is harmony now; if I see something that is out of place, especially color-wise, I would fix it here. As a little tip, whenever you feel that your colors look dirty or dull, try to add saturation to them ‒ shadows have colors too. I look at my image for the last time to see if it serves the main goal of my story. If it does, then I’m done. Otherwise, as an artist, you would never want to call a piece done, so you just have to stop at a certain point. The shadow and lights are almost done. The character’s position is changed to get a better/clearer silhouette Add colors and overall mood to the image. This leads the image towards its purpose and story Finalizing, touch-ups, and enhancing the image’s overall contrast and depth
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Amin Faramarzeyan artstation.com/artist/ aminfara



 LayerPaint allows you to browse the gallery, interviews, news, tutorials and products all dedicated to 2D digital art. On top of that, we have included a free custom brushes library that is available to everyone. We wish LayerPaint to be a definitive resource for digital painting, creating a friendly and educational environment that not only helps budding and experienced CG artists alike, but also showcases some of the best computer generated artwork in the world.
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 Brush up on the latest digital painting techniques with the sixth volume of this essential series for any digital artist. “The latest edition of Digital Painting Techniques is a wonderful collection of tutorials, giving unique insight into the creative processes of many industry-leading artists. It will be a great addition to any creative’s reference library, professional and novice alike. Well worth checking out!” Derek Stenning, Concept Artist and Illustrator, www.borninconcrete.com



Now in its sixth year, Digital Painting Techniques: Volume 6 continues the tradition of showcasing the latest digital painting trends and techniques, from industry experts including Carlos Cabrera (Applibot) and Jan Urschel (Assassin’s Creed IV: Black Flag). In this latest volume, artists will learn about the development of character moods, creating fantasy battles and environments, building sci-fi worlds, and the fundamental aspects of lighting and atmosphere, forming another great addition to any artist’s shelf. This book is the perfect resource for: • Matte painters and concept artists for the TV, film, and game industries • Lecturers and students teaching/studying fine art courses where they are starting to embrace digital painting as a valuable medium • 3D artists who want to improve their texture painting and backdrop paintings • Photographers who want to branch out and use Photoshop for more than just corrections and touch-ups • Hobbyists who want to learn useful tips and tricks from the best artists in the industry



SOFTBACK 216 x 279mm 288 FULL COLOUR PAGES ISBN: 9781909414112



3DTOTALPUBLISHING For more information about our full range of books, please visit: shop.3dtotal.com
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The Artist



– Bram ‘Boco’ Sels



Bram ‘Boco’ Sels artofboco.com



Software Used: Photoshop As a freelance illustrator and concept artist Bram has recently worked for companies like Ubisoft, Wideshot Entertainment, Marauder Film, Tokkun Studios and Centipede Press. Apart from that he’s working as a concept artist for the Belgium-based studio GriN on their upcoming indie title Woolfe: The Red Hood Diaries.



Beginner’s Guide to Digital Painting in Photoshop: Characters



Character generation: Body type and skin by Bram ‘Boco’ Sels



Bram ‘Boco’ Sels reveals top techniques for figure drawing and painting realistic skin textures
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In this section we’ll look in-depth at how to create a heroic 19th-Century character for a videogame. It’s tailored to concept artists who are just starting out, as well as more experienced concept artists who are looking to hone their skills. The approach is simple: each chapter starts with some insightful theory, followed by an explanation on how to create part of the character, all leading up to the polished hero pose in the final chapter. By following this step-by-step tutorial your designs will become more flexible and you’ll be able to quickly do thousands of iterations of the same subject without effort. Don’t like the head of your character? Just unscrew and replace it with a new one. Not sure about his mustache? We have a few others in stock for you! We’ll go over all the basics you’ll need to paint a flexible easy-to-adapt character ready for the production pipeline of the AAA-studio of your dreams. And to top it all off, this section is filled to the brim with quick tips such as how to use the Pen Pressure toggle to your benefit, how to create your own textured brushes, how to use the free PaintersWheel palette, how to make your character feel gritty by applying the Noise filter, and how to conjure mood with custom fog and particle layers. My fingers are tingling to get cracking! 126 | 2DARTISTMAG.COM



– Bram ‘Boco’ Sels



 2DARTIST MAGAZINE | ISSUE 111



01



Warm-up 1.0: When I start on a new piece I almost always do a warm-up first. This is a step that a lot of beginner artists are tempted to skip. Mainly because they feel it’s a waste of time and working on an epic environment or character is so much cooler than doing small anatomy sketches or perspective studies. It is, however, a step that I feel is absolutely necessary for two important reasons. First and foremost, your painting techniques quickly improve if you do some studies every day, and it broadens your horizon a lot, too. It forces you to paint different subjects in rapid succession, learning something new with every session. Second, though warming up seems like a waste of time when you have a deadline coming up, a good warm-up makes you paint faster and more fluently, so you’ll regain that time (and even more) throughout the rest of the day.



02



Figure studies: Every art-school student goes through figure-study classes. The reason for this is that the human body is often the main focal point of an illustration and is very



hard to master. We are constantly looking and interacting with other humans, so our eyes are trained to quickly detect inaccuracies when we see a human body in a painting. The good news is that it’s just a matter of practice. When you do figure studies (and you can’t do enough!) you start to notice how light impacts the body, how muscles connect, and how perspective and foreshortening change what we see of the body. Practice every day and you’ll get better in no time. Image 02 took me around 30 minutes.
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The human machine: Of course, the human body is different for every person, but a reigning theory in art is that it all starts from a perfect base – an ideal body that can be modified to create different body types. So following that theory you start out by learning how that perfect body works. There are different approaches to doing that, but one of the more famous ones is that of Andrew Loomis, an influential American illustrator, art instructor, and author. Part of this approach involves measuring body parts against each other in order to get



proportions correct. For instance, the ideal body is made up of 7–8 heads, so when you draw the head you can quickly measure where the feet should be. The crotch is exactly in the middle of the body and the bottom of the breasts and knees are in the middle of their respective halves. The body is also three heads wide and the shoulders and crotch should create an imaginary triangle that goes between them.



Some really quick anatomy studies, each taking about 5–10 minutes A longer study of around 30 minutes A blueprint of the perfect body. Really focus on how body parts are positioned around the center line
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Imaginary heroes: Up until now the only thing we have done is study the perfect human form and how it’s translated to a drawing, but what if you don’t have an exact reference for what you want to draw? As an illustrator or concept artist you should be free to draw whatever you can imagine, so copying a reference 1:1 will get you nowhere. (Unless you have a bearded dwarf or an alien locked up in your basement, that is.) Artists often have to draw bodies for which they don’t have a reference, so an easy alternative is to start with a shell that looks like a human and for which you do find a reference. That ‘skeleton’ is easy to draw, can be moved around and posed without much work, and afterwards you can draw whatever you want on top using your (human) reference as a guide. Drawing a small muscled dwarf for example? Just broaden the head, ribcage, and hip, and move them closer together.
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An ancient Greek hero: Around 500 BC the Greek sculptors became masters of anatomy by studying the ideal body and creating millions of sculptures to its likeness. They almost always placed the weight of the body on one leg, making the sculpture a lot more dynamic. Compare this body to the blueprint of the body in image 03 and notice how the entire body language changes, even though it’s based on the
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– Bram ‘Boco’ Sels



PRO TIP Pen Pressure



Photoshop CS6 and upwards comes with some cool new brushes that are perfect for digital artists. These brushes mimic how an actual brush works and come with a small pop-up window that shows how Photoshop is registering your brush on the canvas. Tilt your stylus and you’ll get a flat line; push hard and you’ll get a fat line. Nifty and great to do line art with, it prevents you from getting monotonous line work. Another new gimmick is the Pen Pressure toggle next to the Opacity slider on top. When you have it on the harder setting, you press on your stylus and the more opaque ‘ink’ will flow out of it, which is a bit more intuitive than working with the Opacity slider itself.



Opacity slider



Pen Pressure toggle
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same blueprint. Closely study how the muscles group and how the center of gravity slightly moves towards the left.
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Key light/back light: Trying to figure out how to light a body might feel difficult and overwhelming at first, but it becomes a lot less daunting when you go at it one step at a time. A great tip is to start out in black-and-white. That way you can focus on the values without being distracted by the color and temperature of the skin. A body with correct values but wrong color still looks okay, but a body with wrong values quickly looks anatomically incorrect. Another great trick is to define the lighting scheme on a ball before starting on the body. A common lighting scheme in concept art is with a key light (the main light) from the front and a rim light (back light) from behind. Note in image 06 how the muscles react almost the same to the light as the ball.



An easy-to-draw skeleton and how it translates to different body types The ideal body, leaning on his right leg Defining the light scheme on a little ball helps to organize things
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PRO TIP Lock transparent pixels



When you’re working on a character, masking is always one of the first things you should do. Basically it means you paint the silhouette of the character you’re working on and use it as a stencil. Create a layer below the line art to act as a mask and in the top of the Layers palette you can lock transparent pixels, which blocks off all pixels in that layer that are empty (in other words, everything outside the silhouette). Now when you’re painting you don’t have to mind the size of the brush you’re using, since all paint will stay neatly inside the mask.
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The body as a whole: Keep in mind that the body remains a volume in itself. Try to see it as a giant cylinder and think about how that giant cylinder would react to the lighting scheme you defined in step 06. It’s not enough to define every muscle according to the lighting scheme; you should also keep in mind where those muscles are on the body. If they are on the lighter side of the ‘cylinder’, they will of course be lighter than the other side. This is most clear in the biceps of both the arms. The right bicep is on the lighter side of the body and is almost entirely lit, while the left bicep hides in the shadows caused by the chest that sticks out and blocks the light.
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Highlights, midtones, and shadows: After adding in the basic values, try to define a color scheme. Different lighting conditions have a different impact on the body, but for this study we’re keeping the light neutral so the skin tones will be fairly neutral as well. Caucasian skin tones often range from purple to deep red, to yellow and even green. When you look closely at a person’s skin, you’ll see that there’s a lot more information there than you might expect. Still, it’s best to define some common skin colors at first and start from there. I usually change the painting mode of my brush (you can find that in the Options bar at the top of



Photoshop) to Color, and give the entire body a color wash; in this case a warm, orangey tan.
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Color zones: Often skin tends to have areas where a certain color dominates over all other colors. Once you’re familiar with these zones it becomes easier to notice them and eventually predict how the skin there will react to the light. When you move lower down the body, skin tones will gradually become more reddish and purple than they are around the chest area, where they’ll be more yellow and orange. You can especially see this in the hands, knees, and feet. This has
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its effect on the shadows as well, resulting in dark purple shadows in those areas and warm shadows around the chest. Look for some references when painting these areas – they will really help out a lot to get your figure correct and realistic!
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Refining the body: The last step in this chapter consists of refining and detailing.



Although you already defined the values a few steps back, you should still keep working on them – nothing is set in stone at this point. Push the highlights as much as you can and try to create lively shadows by introducing vibrant colors to the darker parts and areas. Take a step back from it once in a while, so you can come back to it with a fresh eye later on. It often makes you notice the mistakes and gives you a fresh perspective.



The value block-out for the body Defining the skin colors; the arrow points towards the main wash The body gradually becomes more reddish near the bottom
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 NEXT MONTH Insightful new interviews Improve your concept vehicle designs Master the art of speed-painting Design and sketch a fantasy character with Brun Croes An inspiring sketchbook of a talented digital artist Learn how to digital paint pin-up girls Mikhail Rakhmatullin shares his painting process 10 of the best 2D images from around the world PLUS MORE!
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